
Q .1Q .1 Who among the fo l lowing part ic ipated in a l l  the three Round Table C onferences?Who among the fo l lowing part ic ipated in a l l  the three Round Table C onferences?
A nsA ns 1. 

2. 
3. 
4. 

Q .2Q .2 Whic h of the fo l lowing s tatement(s)  is/are c orrec t  regarding the d is tr ibution of the populat ion of Hindus ,  M us l ims  and Buddhis tsWhic h of the fo l lowing s tatement(s)  is/are c orrec t  regarding the d is tr ibution of the populat ion of Hindus ,  M us l ims  and Buddhis ts
in Ind ia?in India?

1 .  H indus  make up a major ity  of  the populat ion in mos t  s tates ,  with their  c oncentrat ion ranging from 70 - 90 % or  above.1 .  H indus  make up a major ity  of  the populat ion in mos t  s tates ,  with their  c oncentrat ion ranging from 70 - 90 % or  above.
2 .  M us l ims ,  the larges t  rel igious  minor ity ,  are predominantly  loc ated in urban areas  of M aharas htra and G ujarat .2 .  M us l ims ,  the larges t  rel igious  minor ity ,  are predominantly  loc ated in urban areas  of M aharas htra and G ujarat .
3.  Buddhis ts  have s ignific ant populat ions  in Jammu and Kas hmir  and the Decc an P lateau.3.  Buddhis ts  have s ignific ant populat ions  in Jammu and Kas hmir  and the Decc an P lateau.

A nsA ns 1. Only 1
2. Only 2 and 3
3. 1, 2 and 3
4. Only 3

Q .3Q .3 A t whic h of the fo l lowing venues  was  Badminton India  O pen 2 0 24  held?A t whic h of the fo l lowing venues  was  Badminton India  O pen 2 0 24  held?
A nsA ns 1. 

2. 
3. 
4. 

Q .4Q .4 Whic h of the fo l lowing s oc ia l  reformers  was  NO T as s oc iated with the A ry a S amaj?Whic h of the fo l lowing s oc ia l  reformers  was  NO T as s oc iated with the A ry a S amaj?
A nsA ns 1. Swami Vivekananda

2. Dayanand Saraswati
3. Lala Hansraj
4. Lala Lajpat Rai

Q . 5Q . 5 Who thought that  Q ueen Razia's  rule went agains t  the ideal  s oc ia l  order  c reated by  G od ,  in whic h women were s uppos ed to  beWho thought that  Q ueen Razia's  rule went agains t  the ideal  s oc ia l  order  c reated by  G od ,  in whic h women were s uppos ed to  be
s ubordinate to  men?s ubordinate to  men?

A nsA ns 1. Hasan Nizami 
2. Amir Khusrau
3. Minhaj-i-Siraj 
4. Ibn Batutah 

Q .6Q .6 In June 2 0 24 ,  the E uropean C ommis s ion ( E C )  removed whic h of the fo l lowing c ountr ies  from the l is t  of  c ountr ies  el igible for  itsIn June 2 0 24 ,  the E uropean C ommis s ion ( E C )  removed whic h of the fo l lowing c ountr ies  from the l is t  of  c ountr ies  el igible for  its
€ 1 8 mil l ion c ons ervat ion grant to  be launc hed in E as t  A fr ic a as  part  of  its  NaturA fr ic a init iat ive?€ 1 8 mil l ion c ons ervat ion grant to  be launc hed in E as t  A fr ic a as  part  of  its  NaturA fr ic a init iat ive?

A nsA ns 1. Zambia
2. Tanzania
3. Somalia
4. Kenya

Q .7Q .7 The S k i l l  Ind ia  M is s ion,  as  announced in Budget 2 0 24 -2 5,  trained ______ y outh.The S k i l l  Ind ia  M is s ion,  as  announced in Budget 2 0 24 -2 5,  trained ______ y outh.
A nsA ns 1. 2.1 crore

2. 2.4 crore
3. 1.1 crore
4. 1.4 crore
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Q .8Q .8 Dr.  S al im A l i ,  was  the pre- eminent ornithologis t  of  Ind ia ,  famous ly  known as  the __________ .Dr.  S al im A l i ,  was  the pre- eminent ornithologis t  of  Ind ia ,  famous ly  known as  the __________ .
A nsA ns 1. Birdman of India

2. River man of India
3. Mountain man of India
4. Waterman of India

Q .9Q .9 Whic h of the fo l lowing phy s iographic  d iv is ions  of Ind ia  has  the maximum height?Whic h of the fo l lowing phy s iographic  d iv is ions  of Ind ia  has  the maximum height?
A nsA ns 1. The Peninsular Plateau

2. The Coastal Plains
3. The Northern Plains
4. The Indian Desert

Q .1 0Q .1 0 Whic h of the fo l lowing is  NO T a migratory  bird  in Ind ia?Whic h of the fo l lowing is  NO T a migratory  bird  in Ind ia?
A nsA ns 1. Siberian Crane

2. Amur Falcon
3. Sparrow
4. Flamingo

Q .1 1Q .1 1 M itra M ela ,  a  s ec ret  s oc iety ,  was  founded in 1 899 by  whic h of the fo l lowing indiv iduals?M itra M ela ,  a  s ec ret  s oc iety ,  was  founded in 1 899 by  whic h of the fo l lowing indiv iduals?
A nsA ns 1. Bipin Chandra Pal and Lala Lajpat Rai

2. Lala Lajpat Rai and Mazzini Charitra
3. Vinayak Damodar Savarkar and Ganesh Damodar Savarkar
4. Bal Gangadhar Tilak and Lala Lajpat Rai

Q .1 2Q .1 2 A rt ic le 3 4 0  of the C ons t itut ion of Ind ia  deals  with the:A rt ic le 3 4 0  of the C ons t itut ion of Ind ia  deals  with the:
A nsA ns 1. formation of the Election Commission

2. creation of the Planning Commission
3. appointment of a Commission to investigate the conditions of backward classes
4. establishment of the Finance Commission

Q .1 3Q .1 3

A nsA ns 1. a) i, b) iv, c) iii, d) ii
2. a) iii, b) i, c) iv, d) ii
3. a) iv, b) ii, c) i, d) iii
4. a) i, b) iv, c) ii, d) iii

Q .1 4Q .1 4 Whic h publ ic  s ec tor  bank  launc hed the ‘bob G lobal  Women NRE  & NRO  S avings  A cc ount ’ on 7  M arc h 2 0 2 5,  the firs t  NRI  acc ountWhic h publ ic  s ec tor  bank  launc hed the ‘bob G lobal  Women NRE  & NRO  S avings  A cc ount ’ on 7  M arc h 2 0 2 5,  the firs t  NRI  acc ount
des igned exc lus ively  for  women?des igned exc lus ively  for  women?

A nsA ns 1. Punjab National Bank
2. Canara Bank
3. Bank of Baroda
4. State Bank of India

Q .1 5Q .1 5 Whic h of the fo l lowing qual ific at ions  is  INCO RRE C T for  the appointment of a  judge of the S upreme C ourt?Whic h of the fo l lowing qual ific at ions  is  INCO RRE C T for  the appointment of a  judge of the S upreme C ourt?
A nsA ns 1. He should have been a judge of a High Court for at least five years.

2. He should have been an advocate at a High Court for five years.
3. He should be a distinguished jurist in the opinion of the President.
4. He should be a citizen of India.

Q .1 6Q .1 6 Whic h of the fo l lowing A rt ic les  of  the C ons t itut ion provides  for  the es tabl is hment of High C ourts?Whic h of the fo l lowing A rt ic les  of  the C ons t itut ion provides  for  the es tabl is hment of High C ourts?
A nsA ns 1. Article 224

2. Article 218
3. Article 222
4. Article 214
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Q .1 7Q .1 7 Whic h Indian S tate launc hed the init iat ive ‘S ankalp’ to  c ombat drug traffic king and addic t ion?Whic h Indian S tate launc hed the init iat ive ‘S ankalp’ to  c ombat drug traffic king and addic t ion?
A nsA ns 1. Haryana

2. Uttarakhand
3. Punjab
4. Himachal Pradesh

Q .1 8Q .1 8 A s  of 3 0A s  of 3 0   O c tober  2 0 24 ,  whic h of the fo l lowing pos it ions  does  M s .  A mina J  M ohammed hold  within the United Nations?O c tober  2 0 24 ,  whic h of the fo l lowing pos it ions  does  M s .  A mina J  M ohammed hold  within the United Nations?
A nsA ns 1. Director-General of the United Nations Industrial Development Organization

2. President of the United Nations General Assembly
3. Deputy Secretary-General of the United Nations and Chair of the United Nations Sustainable Development Group
4. Executive Director of the United Nations Environment Programme

Q .1 9Q .1 9 Whic h of the fo l lowing pr iv i leges  is  NO T enjoy ed by  the Pres ident of Ind ia?Whic h of the fo l lowing pr iv i leges  is  NO T enjoy ed by  the Pres ident of Ind ia?
A nsA ns 1. The President can be a Chancellor of any state university.

2. He/She cannot be asked to be present in any court of law during his/her tenure.
3. The President is not answerable to any court of law.
4. A prior notice of two months is to be served before instituting a civil case against him/her.

Q .2 0Q .2 0 M alik  Kafur  was  the c ommander  of ______ .M al ik  Kafur  was  the c ommander  of ______ .
A nsA ns 1. Iltutmish

2. Alauddin Khilji
3. Balban
4. Razia Sultana

Q .2 1Q .2 1 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ter  pairs  are a l ike in a  certain way  and thus  form aBas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ter  pairs  are a l ike in a  certain way  and thus  form a
group.  Whic h letter- c lus ter  pair  DO E S  NO T belong to  that  group?group.  Whic h letter- c lus ter  pair  DO E S  NO T belong to  that  group?
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )

A nsA ns 1. QT-RU
2. JM-KN
3. PS-QT
4. CE-DF

Q .2 2Q .2 2 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .
( L eft)  M  J  U N L  G  T  E  X  S  Q  O  A  I  V  W B  C  H D K ( Right)( L eft)  M  J  U N L  G  T  E  X  S  Q  O  A  I  V  W B  C  H D K ( Right)
How many  letters  are there in the E ngl is h a lphabetic al  s er ies  between the letter  whic h is  third  from the r ight  end and the letterHow many  letters  are there in the E ngl is h a lphabetic al  s er ies  between the letter  whic h is  third  from the r ight  end and the letter
whic h is  fifth from the left  end?whic h is  fifth from the left  end?

A nsA ns 1. One
2. Three
3. Four
4. Two

Q .2 3Q .2 3 If  '+ '  means  '÷ ' ,  '− '  means  '× ' ,  ' × '  means  '− ' ,  and '÷ '  means  '+ ' ,  then what wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowingIf  '+ '  means  '÷ ' ,  '− '  means  '× ' ,  ' × '  means  '− ' ,  and '÷ '  means  '+ ' ,  then what wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing
equation?equation?

3 24  + 6  ×  8  − 3 2  ÷  2 51  = ?3 24  + 6  ×  8  − 3 2  ÷  2 51  = ?
A nsA ns 1. 49

2. 12
3. 38
4. 27

Q .24Q .24 If  2  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 861 3 74 5,  then what wi l l  be the s um of theIf  2  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 861 3 74 5,  then what wi l l  be the s um of the
digits  that  are third  from the left  and s ec ond from the r ight?digits  that  are third  from the left  and s ec ond from the r ight?

A nsA ns 1. 
2. 
3. 
4. 
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Q .2 5Q .2 5 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

2  2  1 1  1 1  2 6  2 6 53  53  98 98 1 67  1 67  ??
A nsA ns 1. 256

2. 266
3. 260
4. 265

Q .2 6Q .2 6 A runa ranked 1 1A runa ranked 1 1t ht h  from the top and 1 9 from the top and 1 9t ht h  from the bottom in her  c las s .  How many  s tudents  are there in the c las s? from the bottom in her  c las s .  How many  s tudents  are there in the c las s?

A nsA ns 1. 30
2. 28
3. 29
4. 31

Q .2 7Q .2 7 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

3 1 ,  3 1 ,  3 5,  3 5,  43,  43,  55,  55,  71 ,  71 ,  ??
A nsA ns 1. 93

2. 91
3. 90
4. 92

Q .2 8Q .2 8 Whic h of the fo l lowing letter- c lus ters  s hould  replace # and % s o that  the pattern and relat ions hip fo l lowed between the letter-Whic h of the fo l lowing letter- c lus ters  s hould  replace # and % s o that  the pattern and relat ions hip fo l lowed between the letter-
c lus ter  pair  on the left  s ide of : :  is  the s ame as  that  on the r ight  s ide of : : ?c lus ter  pair  on the left  s ide of : :  is  the s ame as  that  on the r ight  s ide of : : ?

# :  L PO  : :  E IH  :  %# :  L PO  : :  E IH  :  %
A nsA ns 1. # = MQP, % = DHG

2. # = MSR, % = DHG
3. # = MQO, % = CG F
4. # = MQP, % = DGH

           

Q .2 9Q .2 9 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  
( Note:  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .( Note:  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .
E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and thenE .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and then
performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

( 1 0 5,  51 ,  1 93 )( 1 0 5,  51 ,  1 93 )
( 1 0 9,  4 6 ,  1 92 )( 1 0 9,  4 6 ,  1 92 )

A nsA ns 1. (145, 69, 213)
2. (137, 37, 411)
3. (121, 41, 169)
4. (156, 26, 219)

Q .3 0Q .3 0

A nsA ns 1. 
2. 
3. 
4. 
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Q .3 1Q .3 1 TG  1 9 is  related to  UI  6  in a  certain way .  In the s ame way ,  KJ  3 0  is  related to  L L  1 7.  To  whic h of the given options  is  LC  1 0  related ,TG  1 9 is  related to  UI  6  in a  certain way .  In the s ame way ,  KJ  3 0  is  related to  L L  1 7.  To  whic h of the given options  is  LC  1 0  related ,
fo l lowing the s ame logic ?fo l lowing the s ame logic ?

A nsA ns 1. ME -3
2. MF -7
3. NE -3
4. NF -5

Q .3 2Q .3 2 S even boxes ,  J ,  K ,  L ,  M ,  N,  O  and T,  are kept one over  the other  but not  neces s ar i ly  in the s ame order.  O nly  two boxes  are keptS even boxes ,  J ,  K ,  L ,  M ,  N,  O  and T,  are kept one over  the other  but not  neces s ar i ly  in the s ame order.  O nly  two boxes  are kept
below J .  O nly  one box is  kept above N.  O nly  one box is  kept between N and T.  L  is  kept immediately  above M .  O  is  kept at  s omebelow J .  O nly  one box is  kept above N.  O nly  one box is  kept between N and T.  L  is  kept immediately  above M .  O  is  kept at  s ome
place below K.  How many  boxes  are kept between K and O ?place below K.  How many  boxes  are kept between K and O ?

A nsA ns 1. Three
2. Four
3. Two
4. One

Q .3 3Q .3 3 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  
( Note:  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .( Note:  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .
E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and thenE .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and then
performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

( 3,  3 1 ,  43 )( 3,  3 1 ,  43 )
( 7,  3 6 ,  64)( 7,  3 6 ,  64)

A nsA ns 1. (19, 47, 223)
2. (11, 41, 85)
3. (21, 50, 132)
4. (14, 55, 101)

Q .3 4Q .3 4 If  ‘E ’ s tands  for  ‘+ ’ ,  ‘F ’ s tands  for  ‘ - ’ ,  ‘G ’ s tands  for  ‘÷ ’ and ‘H ’ s tands  for  ‘× ‘  ,  what wi l l  c ome in place of the ques t ion mark  ( ? )  in theIf  ‘E ’ s tands  for  ‘+ ’ ,  ‘F ’ s tands  for  ‘ - ’ ,  ‘G ’ s tands  for  ‘÷ ’ and ‘H ’ s tands  for  ‘× ‘  ,  what wi l l  c ome in place of the ques t ion mark  ( ? )  in the
fo l lowing equation?fo l lowing equation?

24  G  4  E  1 2  H 1  F 1 8  = ?24  G  4  E  1 2  H 1  F 1 8  = ?
A nsA ns 1. -6

2. -3
3. 6
4. 0

Q .3 5Q .3 5 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  and thus  form aBas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  and thus  form a
group.  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?group.  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )

A nsA ns 1. UTP
2. FEA
3. VVQ
4. RQM

Q .3 6Q .3 6 S elec t  the s et  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two s ets  given below.  Both s ets  fo l low the s ame pattern.S elec t  the s et  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two s ets  given below.  Both s ets  fo l low the s ame pattern.

S P – NK – IFS P – NK – IF
TQ  – O L  – JGTQ  – O L  – JG

A nsA ns 1. ED – BX – VT
2. FC – AX - VS
3. ED – AX – WT
4. FC – BX – VS
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Q .3 7Q .3 7 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion.Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion.

( L eft)  4  5 6  7  9  8  1  2  3  3  6  5 4  9  6  4  6  5 4  8  9  8  4  6  5 4  6  5 3  2  ( Right)( L eft)  4  5 6  7  9  8  1  2  3  3  6  5 4  9  6  4  6  5 4  8  9  8  4  6  5 4  6  5 3  2  ( Right)

How many  s uc h even d igits  are there eac h of the whic h is  immediately  preceded by  a  perfec t  s quare and immediately  fo l lowed byHow many  s uc h even d igits  are there eac h of the whic h is  immediately  preceded by  a  perfec t  s quare and immediately  fo l lowed by
an odd d igit?an odd d igit?
( NO TE :  0  and 1  are a ls o  a  perfec t  s quare. )( NO TE :  0  and 1  are a ls o  a  perfec t  s quare. )

A nsA ns 1. Five
2. Four
3. Three
4. Six

Q .3 8Q .3 8 S elec t  the option figure that  wi l l  replace the ques t ion mark  ( ? )  in the figure given below to  c omplete the pattern.S elec t  the option figure that  wi l l  replace the ques t ion mark  ( ? )  in the figure given below to  c omplete the pattern.

A nsA ns 1. 

2. 

3. 

4. 

Q .3 9Q .3 9 Refer  to  the given s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .  ( A l l  numbers  are s ingleRefer  to  the given s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .  ( A l l  numbers  are s ingle
digit  numbers  only)d igit  numbers  only)
( L eft)  8  5 9  6  3  3  5 4  7  8  6  5 8  1  3  5 6  5 1  8  3  7  8  9  8  5 5 ( Right)( L eft)  8  5 9  6  3  3  5 4  7  8  6  5 8  1  3  5 6  5 1  8  3  7  8  9  8  5 5 ( Right)
How many  s uc h odd numbers  are there eac h of whic h is  immediately  preceded by  an odd number and als o  immediately  fo l lowed byHow many  s uc h odd numbers  are there eac h of whic h is  immediately  preceded by  an odd number and als o  immediately  fo l lowed by
an odd number?an odd number?

A nsA ns 1. Seven
2. Five
3. Two
4. Four

Q .4 0Q .4 0 Refer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .Refer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .
( L eft)  ( L eft)  V A I N Y A N A V I H S L A G H T A K O P D R R A D UV A I N Y A N A V I H S L A G H T A K O P D R R A D U ( Right)( Right)

If  a l l  the c ons onants  are dropped from the s er ies ,  whic h letter  wi l l  be s ixth from the r ight?If  a l l  the c ons onants  are dropped from the s er ies ,  whic h letter  wi l l  be s ixth from the r ight?
A nsA ns 1. A

2. I
3. O
4. U

Q .4 1Q .4 1 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .

To move quic k ly  over  the s urfaceTo move quic k ly  over  the s urface
A nsA ns 1. Gliding

2. Skim
3. Swoop
4. Curveting
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Q .4 2Q .4 2 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.
L os e y our  headL os e y our  head

A nsA ns 1. To think logically in a tough situation
2. To physically lose something important
3. To become wiser after a difficult experience
4. To lose control and not act in a calm way

Q .43Q .43 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

He ans wered the ques t ions  as  __________ as  pos s ible.He ans wered the ques t ions  as  __________ as  pos s ible.
A nsA ns 1. accurately

2. decently
3. inaptly
4. inappositely

Q .4 4Q .4 4 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

C ons iderableC ons iderable
A nsA ns 1. Inadequate

2. Usual
3. Common
4. Inattentive

Q .4 5Q .4 5 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

The _______ s i lence in the c ourtroom made every one nervous .The _______ s i lence in the c ourtroom made every one nervous .
A nsA ns 1. smooth

2. slow
3. deafening
4. deaf

C omprehens ion:C omprehens ion:
Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in the modern world. Students today depend heavily on the
internet for accessing information, attending online classes, and connecting with peers through social media platforms. This digital revolution
has undoubtedly made education more flexible and accessible, especially for learners in remote areas. However, it also introduces several
challenges. Prolonged screen time can lead to physical health issues like eye strain and disrupted sleep, while also reducing opportunities for in-
person social interaction. Moreover, not all students have equal access to digital devices and stable internet connections, creating a widening gap
between privileged and underprivileged learners. Despite these concerns, the educational benefits of technology are immense. It supports self-
paced learning, encourages curiosity, and allows teachers to incorporate interactive tools that enhance understanding. Striking the right balance
between digital resources and traditional methods is essential to ensure a holistic and inclusive educational experience.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 What is  the mos t appropr iate t it le for  this  pas s age?What is  the mos t appropr iate t it le for  this  pas s age?
A nsA ns 1. The History of Technology

2. How to Use Social Media Safely
3. Health Problems Due to Technology
4. Technology’s Role in Education
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C omprehens ion:C omprehens ion:
Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in the modern world. Students today depend heavily on the
internet for accessing information, attending online classes, and connecting with peers through social media platforms. This digital revolution
has undoubtedly made education more flexible and accessible, especially for learners in remote areas. However, it also introduces several
challenges. Prolonged screen time can lead to physical health issues like eye strain and disrupted sleep, while also reducing opportunities for in-
person social interaction. Moreover, not all students have equal access to digital devices and stable internet connections, creating a widening gap
between privileged and underprivileged learners. Despite these concerns, the educational benefits of technology are immense. It supports self-
paced learning, encourages curiosity, and allows teachers to incorporate interactive tools that enhance understanding. Striking the right balance
between digital resources and traditional methods is essential to ensure a holistic and inclusive educational experience.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 S elec t  the mos t appropr iate A NTO NYM  of the word 'acces s ible'  as  us ed in the pas s age.S elec t  the mos t appropr iate A NTO NYM  of the word 'acces s ible'  as  us ed in the pas s age.
A nsA ns 1. Easy

2. Available
3. Open
4. Limited

C omprehens ion:C omprehens ion:
Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in the modern world. Students today depend heavily on the
internet for accessing information, attending online classes, and connecting with peers through social media platforms. This digital revolution
has undoubtedly made education more flexible and accessible, especially for learners in remote areas. However, it also introduces several
challenges. Prolonged screen time can lead to physical health issues like eye strain and disrupted sleep, while also reducing opportunities for in-
person social interaction. Moreover, not all students have equal access to digital devices and stable internet connections, creating a widening gap
between privileged and underprivileged learners. Despite these concerns, the educational benefits of technology are immense. It supports self-
paced learning, encourages curiosity, and allows teachers to incorporate interactive tools that enhance understanding. Striking the right balance
between digital resources and traditional methods is essential to ensure a holistic and inclusive educational experience.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 Whic h s entence bes t  s ummaris es  the pas s age?Whic h s entence bes t  s ummaris es  the pas s age?
A nsA ns 1. Technology completely replaces traditional education.

2. Technology only benefits privileged students.
3. Technology transforms education while presenting both advantages and challenges.
4. Technology harms students’ health but offers some benefits.

C omprehens ion:C omprehens ion:
Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in the modern world. Students today depend heavily on the
internet for accessing information, attending online classes, and connecting with peers through social media platforms. This digital revolution
has undoubtedly made education more flexible and accessible, especially for learners in remote areas. However, it also introduces several
challenges. Prolonged screen time can lead to physical health issues like eye strain and disrupted sleep, while also reducing opportunities for in-
person social interaction. Moreover, not all students have equal access to digital devices and stable internet connections, creating a widening gap
between privileged and underprivileged learners. Despite these concerns, the educational benefits of technology are immense. It supports self-
paced learning, encourages curiosity, and allows teachers to incorporate interactive tools that enhance understanding. Striking the right balance
between digital resources and traditional methods is essential to ensure a holistic and inclusive educational experience.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 Whic h of the fo l lowing is  a  ' text  to  wor ld '  c onnec t ion from the pas s age?Whic h of the fo l lowing is  a  ' text  to  wor ld '  c onnec t ion from the pas s age?
A nsA ns 1. Many students around the world use technology to learn.

2. The passage is about one school’s computer lab.
3. The author prefers traditional learning methods.
4. Technology is only important in science classes.
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C omprehens ion:C omprehens ion:
Read the given passage carefully and answer the questions that follow.

Technology has significantly transformed how we live, study, and communicate in the modern world. Students today depend heavily on the
internet for accessing information, attending online classes, and connecting with peers through social media platforms. This digital revolution
has undoubtedly made education more flexible and accessible, especially for learners in remote areas. However, it also introduces several
challenges. Prolonged screen time can lead to physical health issues like eye strain and disrupted sleep, while also reducing opportunities for in-
person social interaction. Moreover, not all students have equal access to digital devices and stable internet connections, creating a widening gap
between privileged and underprivileged learners. Despite these concerns, the educational benefits of technology are immense. It supports self-
paced learning, encourages curiosity, and allows teachers to incorporate interactive tools that enhance understanding. Striking the right balance
between digital resources and traditional methods is essential to ensure a holistic and inclusive educational experience.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 A cc ording to  the pas s age,  what is  one c hal lenge of tec hnology  in educ at ion?A cc ording to  the pas s age,  what is  one c hal lenge of tec hnology  in educ at ion?
A nsA ns 1. It reduces access to information.

2. It eliminates teachers’ roles.
3. It causes excessive screen time.
4. It makes lessons boring.

Q . 51Q . 51 Zन\]ल_ख तZन\]ल_ख त   वा dवा d   कोको   gद एgद ए   ग एग ए   Zवक klZवक kl   मnमn   सेसे   उ प युuउ प युu   का र कका र क   केके   wा राwा रा   प ूणzप ूणz   क रnक रn ।।
घो ड़ेघो ड़े  _____  _____ चढ़ नेचढ़ ने   वा लावा ला   हरहर   को ईको ई   घ ुड़ सवा रघुड़ सवा र   नह�नह�   होहो   जा ताजा ता

A nsA ns 1. पर
2. मn
3. से
4. पे

Q . 52Q . 52 '' आ ड़ेआ ड़े   हा थlहा थl   लेनालेना '  '  मुहा वरेमुहा वरे   काका   सहीसही   अथzअथz   हैहै  - -
A nsA ns 1. हो]शयार बनना

2. चोर� करना
3. खर�-खोटी सुनाना
4. गाल बजाना

Q . 53Q . 53 Zन\]ल_ख तZन\]ल_ख त   Zवक klZवक kl   मnमn   सेसे  ‘ ‘ बंधनबंधन ’ ’ काका   Zवलो मZवलो म   श�श�   कौ नकौ न -- सासा   हैहै ??
A nsA ns 1. अभ�

2. बुरा
3. घृणा
4. मु�u

Q . 54Q . 54 '' च� टीच� टी   केके   प रप र   Zनक लनाZनक लना '  '  मुहा वरेमुहा वरे   काका   सहीसही   अथzअथz   हो गाहो गा --
A nsA ns 1. मरने के gदन Zनकट आना

2. खु]शय� मनाना
3. पीटने क� इ�ा होना
4. सीमा के बाहर जाना

Q . 55Q . 55 '' क प ड़ाक प ड़ा '  '  काका   प य� यवा चीप य� यवा ची   श�श�   हो गाहो गा  - -
A nsA ns 1. मोद

2. चीर
3. जलज
4. धाम
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C omprehens ion:C omprehens ion:
gदए गए ग��श के आधार पर Zन\�िकत ��l के उ�र दी]जए-
रेखा च¡ श�  च¡कला के ¢ेच श� का पय�य है। इसमn रेखाओं के सहारे ¤�u या व¥ु का भावपूणz  च¡ �¥ुत िकया जाता है। इ¦n ¤�u- च¡, श�- च¡, च§रत- च¡, श��कन
आgद भी कहा जाता है। रेखा च¡ मn श� वही कायz करते ह̈ जो  च¡कला मn रेखाएँ करती ह̈। रेखा च¡ मn कुछ चुने हुए श�l wारा Zवषय-व¥ु, ¤�u, ¬ान, घटना एवं ­® को साकार ¯प
मn इस तरह �¥ुत िकया जाता है िक पाठक के सामने पूर�  तरह  चि¡त हो सके। रेखा च¡ मn ¤�u के ±¯प क� बा² रेखाओं को उभारा जाता है, उसक� चे³ाओं को �¥ुत करने का
�यास होता है। वणzना´कता रेखा च¡ का आधार होती है। उसमn  च¡ा´कता पर Zवशेष बल gदया जाता है। रेखा च¡ यथाथzवादी रचना है। भाषा क� सहजता और सरलता पर अ¶धक बल
gदया जाता है। छोटे-छोटे वाd और ±ाभाZवक संवाद रेखा च¡ क� Zवशेषता है। देवn� स·ाथ¸ (रेखाएँ बोल उठ¹), �काशचंद गुº (शेरशाह क� सड़क), �ेमनारायण (gहदंी लेखक),
रामवृ»बेनी पुर�  (पहली वष�) आgद �मुख रेखा च¡कार ह̈।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 रेखा  च¡रेखा  च¡   क�क�   भा षाभा षा   क�क�   Zवशेष ताZवशेष ता   Zन\Zन\   मnमn   सेसे   हैहै ——
A nsA ns 1. जिटल वाd

2. ½¾³ भाषा
3. कgठन श�ावली
4. छोटे-छोटे वाd

C omprehens ion:C omprehens ion:
gदए गए ग��श के आधार पर Zन\�िकत ��l के उ�र दी]जए-
रेखा च¡ श�  च¡कला के ¢ेच श� का पय�य है। इसमn रेखाओं के सहारे ¤�u या व¥ु का भावपूणz  च¡ �¥ुत िकया जाता है। इ¦n ¤�u- च¡, श�- च¡, च§रत- च¡, श��कन
आgद भी कहा जाता है। रेखा च¡ मn श� वही कायz करते ह̈ जो  च¡कला मn रेखाएँ करती ह̈। रेखा च¡ मn कुछ चुने हुए श�l wारा Zवषय-व¥ु, ¤�u, ¬ान, घटना एवं ­® को साकार ¯प
मn इस तरह �¥ुत िकया जाता है िक पाठक के सामने पूर�  तरह  चि¡त हो सके। रेखा च¡ मn ¤�u के ±¯प क� बा² रेखाओं को उभारा जाता है, उसक� चे³ाओं को �¥ुत करने का
�यास होता है। वणzना´कता रेखा च¡ का आधार होती है। उसमn  च¡ा´कता पर Zवशेष बल gदया जाता है। रेखा च¡ यथाथzवादी रचना है। भाषा क� सहजता और सरलता पर अ¶धक बल
gदया जाता है। छोटे-छोटे वाd और ±ाभाZवक संवाद रेखा च¡ क� Zवशेषता है। देवn� स·ाथ¸ (रेखाएँ बोल उठ¹), �काशचंद गुº (शेरशाह क� सड़क), �ेमनारायण (gहदंी लेखक),
रामवृ»बेनी पुर�  (पहली वष�) आgद �मुख रेखा च¡कार ह̈।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 Zन\Zन\   मnमn   सेसे   रे खा  च¡रे खा  च¡   काका   प य� यप य� य   नह�नह�   हैहै ——
A nsA ns 1. च§रत  च¡

2. ¢ेच
3. घटना¿म
4. ¤�u  च¡

C omprehens ion:C omprehens ion:
gदए गए ग��श के आधार पर Zन\�िकत ��l के उ�र दी]जए-
रेखा च¡ श�  च¡कला के ¢ेच श� का पय�य है। इसमn रेखाओं के सहारे ¤�u या व¥ु का भावपूणz  च¡ �¥ुत िकया जाता है। इ¦n ¤�u- च¡, श�- च¡, च§रत- च¡, श��कन
आgद भी कहा जाता है। रेखा च¡ मn श� वही कायz करते ह̈ जो  च¡कला मn रेखाएँ करती ह̈। रेखा च¡ मn कुछ चुने हुए श�l wारा Zवषय-व¥ु, ¤�u, ¬ान, घटना एवं ­® को साकार ¯प
मn इस तरह �¥ुत िकया जाता है िक पाठक के सामने पूर�  तरह  चि¡त हो सके। रेखा च¡ मn ¤�u के ±¯प क� बा² रेखाओं को उभारा जाता है, उसक� चे³ाओं को �¥ुत करने का
�यास होता है। वणzना´कता रेखा च¡ का आधार होती है। उसमn  च¡ा´कता पर Zवशेष बल gदया जाता है। रेखा च¡ यथाथzवादी रचना है। भाषा क� सहजता और सरलता पर अ¶धक बल
gदया जाता है। छोटे-छोटे वाd और ±ाभाZवक संवाद रेखा च¡ क� Zवशेषता है। देवn� स·ाथ¸ (रेखाएँ बोल उठ¹), �काशचंद गुº (शेरशाह क� सड़क), �ेमनारायण (gहदंी लेखक),
रामवृ»बेनी पुर�  (पहली वष�) आgद �मुख रेखा च¡कार ह̈।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 '' ±ा भा Zवक±ा भा Zवक '  '  काका   Zवलो मZवलो म   श�श�   Zन\Zन\   मnमn   सेसे   हैहै - -- -
A nsA ns 1. अव±ाभाZवक

2. वा¥Zवक
3. अ±ाभाZवक
4. �ाकृZतक
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C omprehens ion:C omprehens ion:
gदए गए ग��श के आधार पर Zन\�िकत ��l के उ�र दी]जए-
रेखा च¡ श�  च¡कला के ¢ेच श� का पय�य है। इसमn रेखाओं के सहारे ¤�u या व¥ु का भावपूणz  च¡ �¥ुत िकया जाता है। इ¦n ¤�u- च¡, श�- च¡, च§रत- च¡, श��कन
आgद भी कहा जाता है। रेखा च¡ मn श� वही कायz करते ह̈ जो  च¡कला मn रेखाएँ करती ह̈। रेखा च¡ मn कुछ चुने हुए श�l wारा Zवषय-व¥ु, ¤�u, ¬ान, घटना एवं ­® को साकार ¯प
मn इस तरह �¥ुत िकया जाता है िक पाठक के सामने पूर�  तरह  चि¡त हो सके। रेखा च¡ मn ¤�u के ±¯प क� बा² रेखाओं को उभारा जाता है, उसक� चे³ाओं को �¥ुत करने का
�यास होता है। वणzना´कता रेखा च¡ का आधार होती है। उसमn  च¡ा´कता पर Zवशेष बल gदया जाता है। रेखा च¡ यथाथzवादी रचना है। भाषा क� सहजता और सरलता पर अ¶धक बल
gदया जाता है। छोटे-छोटे वाd और ±ाभाZवक संवाद रेखा च¡ क� Zवशेषता है। देवn� स·ाथ¸ (रेखाएँ बोल उठ¹), �काशचंद गुº (शेरशाह क� सड़क), �ेमनारायण (gहदंी लेखक),
रामवृ»बेनी पुर�  (पहली वष�) आgद �मुख रेखा च¡कार ह̈।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 '' शेर शा हशेर शा ह   क�क�   सड़ कसड़ क '  '  केके   लेख कलेख क   Zन\Zन\   मnमn   सेसे   हैहै ——
A nsA ns 1. रामवृ» बेनीपुर�

2. �ेमनारायण
3. �काशचंद गुº
4. देवn� स·ाथ¸

C omprehens ion:C omprehens ion:
gदए गए ग��श के आधार पर Zन\�िकत ��l के उ�र दी]जए-
रेखा च¡ श�  च¡कला के ¢ेच श� का पय�य है। इसमn रेखाओं के सहारे ¤�u या व¥ु का भावपूणz  च¡ �¥ुत िकया जाता है। इ¦n ¤�u- च¡, श�- च¡, च§रत- च¡, श��कन
आgद भी कहा जाता है। रेखा च¡ मn श� वही कायz करते ह̈ जो  च¡कला मn रेखाएँ करती ह̈। रेखा च¡ मn कुछ चुने हुए श�l wारा Zवषय-व¥ु, ¤�u, ¬ान, घटना एवं ­® को साकार ¯प
मn इस तरह �¥ुत िकया जाता है िक पाठक के सामने पूर�  तरह  चि¡त हो सके। रेखा च¡ मn ¤�u के ±¯प क� बा² रेखाओं को उभारा जाता है, उसक� चे³ाओं को �¥ुत करने का
�यास होता है। वणzना´कता रेखा च¡ का आधार होती है। उसमn  च¡ा´कता पर Zवशेष बल gदया जाता है। रेखा च¡ यथाथzवादी रचना है। भाषा क� सहजता और सरलता पर अ¶धक बल
gदया जाता है। छोटे-छोटे वाd और ±ाभाZवक संवाद रेखा च¡ क� Zवशेषता है। देवn� स·ाथ¸ (रेखाएँ बोल उठ¹), �काशचंद गुº (शेरशाह क� सड़क), �ेमनारायण (gहदंी लेखक),
रामवृ»बेनी पुर�  (पहली वष�) आgद �मुख रेखा च¡कार ह̈।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 रे खा  च¡रे खा  च¡   केके   सÀंधसÀंध   मnमn   अस·अस·   हैहै ——
A nsA ns 1. रेखा च¡ काkZनक रचना होती है

2. रेखा च¡ मn  च¡ा´कता पर Zवशेष बल gदया जाता है।
3. वणzना´कता रेखा च¡ का आधार होती है।
4. रेखा च¡ यथाथzवादी रचना होती है।

Q .61Q .61 Whic h of the fo l lowing s tatements  is  true when s ort ing data in M S  E xcel?Whic h of the fo l lowing s tatements  is  true when s ort ing data in M S  E xcel?
A nsA ns 1. When sorting data, MS Excel automatically ignores blank cells in the dataset.

2. MS Excel allows users to sort data in ascending or descending order, but they cannot sort multiple columns simultaneously.
3. Data sorting in MS Excel only works with numerical values and not with text data.
4. Sorting data in MS Excel can be done by selecting one column, but if a user wants to sort by multiple criteria, they must use the Custom

Sort option.

Q .62Q .62 What is  the pr imary  d is t inguis hing feature of a  poly morphic  v irus  c ompared to  other  ty pes  of v irus es?What is  the pr imary  d is t inguis hing feature of a  poly morphic  v irus  c ompared to  other  ty pes  of v irus es?
A nsA ns 1. It only infects executable files.

2. It encrypts itself with different keys each time it replicates.
3. It remains dormant until a specific condition is met.
4. It spreads through email attachments.

Q .63Q .63
A nsA ns 1. 

2. 
3. 
4. 

Q .64Q .64 In M S  Word ,  whic h of the fo l lowing s teps  provides  a  detai led  pr int  preview that  a l lows  us ers  to  adjus t  s ett ings  s uc h as  margins ,In M S  Word ,  whic h of the fo l lowing s teps  provides  a  detai led  pr int  preview that  a l lows  us ers  to  adjus t  s ett ings  s uc h as  margins ,
page or ientat ion,  and paper  s ize before pr int ing the doc ument?page or ientat ion,  and paper  s ize before pr int ing the doc ument?

A nsA ns 1. Go to the View tab, select Print Layout, and then click on Print Preview.
2. Go to the File tab, select Print, and then click on Page Setup at the bottom of the Print Preview pane.
3. Right-click on the document, select Print, and then choose Print Preview from the context menu.
4. Go to the File tab, select Print, and then adjust settings directly in the Print Preview pane.
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Q .65Q .65 Whic h tab in the to l lbar  a l lows  y ou to  ins ert  images  into  y our  M ic ros oft  PowerPoint  pres entat ion?Whic h tab in the to l lbar  a l lows  y ou to  ins ert  images  into  y our  M ic ros oft  PowerPoint  pres entat ion?
A nsA ns 1. Slide Show

2. Home
3. Design
4. Insert

Q .66Q .66
A nsA ns 1. 

2. 
3. 
4. 

Q .67Q .67 When s tart ing M S  PowerPoint ,  whic h of the fo l lowing options  is  the c orrec t  way  to  c reate a  new blank  pres entat ion?When s tart ing M S  PowerPoint ,  whic h of the fo l lowing options  is  the c orrec t  way  to  c reate a  new blank  pres entat ion?
A nsA ns 1. Right-click on the desktop and choose New > PowerPoint Presentation.

2. Open the View tab and select Blank Presentation.
3. Select File > New > Blank Presentation and click Create.
4. Click on the Insert tab and choose Blank Slide.

Q .68Q .68 Whic h of the fo l lowing is  the default  meas urement unit  for  page margins  in M S - Word?Whic h of the fo l lowing is  the default  meas urement unit  for  page margins  in M S - Word?
A nsA ns 1. Inches

2. Millimetres
3. Centimetres
4. Points

Q .69Q .69 What maintains  the s y s tem res ources  and gives  the path for  appl ic at ion s oftware to  run?What maintains  the s y s tem res ources  and gives  the path for  appl ic at ion s oftware to  run?
A nsA ns 1. Anti-virus Software

2. Task Manager
3. System Notification
4. System Software

Q .70Q .70 The s hortc ut key s  to  a l ign the text  L eft ,  Right ,  C enter  and Jus t ify  text  in M S  Word 2 0 1 9 are:The s hortc ut key s  to  a l ign the text  L eft ,  Right ,  C enter  and Jus t ify  text  in M S  Word 2 0 1 9 are:
A nsA ns 1. Left-align text – Press Shift + L; Right-align text – Press Shift + R; Center text – Shift + E; Justify text – Shift + J

2. Left-align text – Press Ctrl + L; Right-align text – Press Ctrl + R; Center text – Ctrl + E; Justify text – Ctrl + J
3. Left-align text – Press Alt + L; Right-align text – Press Alt + R; Center text – Alt + E; Justify text – Alt + J
4. Left-align text – Press Ins + L; Right-align text – Press Ins + R; Center text – Ins + E; Justify text – Ins + J

Q .71Q .71 Whic h of the fo l lowing s tatements  about input and output devices  is  true?Whic h of the fo l lowing s tatements  about input and output devices  is  true?
A nsA ns 1. A modem is solely an output device.

2. A touchscreen is only an input device.
3. A barcode reader is an output device, and a plotter is an input device.
4. A microphone is an input device, and a projector is an output device.

Q .72Q .72 Whic h ty pe of emai l  protoc ol  a l lows  a us er  to  retr ieve their  emai l  from a mai l  s erver?Whic h ty pe of emai l  protoc ol  a l lows  a us er  to  retr ieve their  emai l  from a mai l  s erver?
A nsA ns 1. STP (Spanning Tree Protocol)

2. IMAP (Internet Message Access Protocol)
3. EmailProtocol
4. FTP (File Transfer Protocol)

Q .73Q .73 If  a  us er  has  s pelt  a  word c orrec t ly  in the way  they  intended and M S  Word is  s t i l l  fl agging words  as  mis s pel led ,  what s hould  theIf  a  us er  has  s pelt  a  word c orrec t ly  in the way  they  intended and M S  Word is  s t i l l  fl agging words  as  mis s pel led ,  what s hould  the
us er  do?us er  do?

A nsA ns 1. Select 'Add to Reservoir'
2. Select 'Add to Book'
3. Select 'Add to Dictionary'
4. Select 'Add to Repository'
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Q .74Q .74 What is  the procedure for  pr int ing row or  c o lumn headers  on eac h page in M S  E xcel  2 0 2 1 ?What is  the procedure for  pr int ing row or  c o lumn headers  on eac h page in M S  E xcel  2 0 2 1 ?
A nsA ns 1. View > Repeat Rows/Columns

2. File > Print > Repeating Labels
3. Page Layout > Print Area > Set Repeating Rows/Columns
4. Page Layout > Page Setup > Print Titles > Rows/Columns to repeat

Q .75Q .75 What is  the purpos e of c hoos ing a t ime window around the s pec ified date in an email?What is  the purpos e of c hoos ing a t ime window around the s pec ified date in an email?
A nsA ns 1. To filter out the unwanted emails

2. To categorise the emails by sender
3. To group the emails received within a specific timeframe
4. To prioritise the emails based on urgency

Q .76Q .76 What is  a  c ommon impac t  of a  c omputer  v irus  on a s y s tem?What is  a  c ommon impac t  of a  c omputer  v irus  on a s y s tem?
A nsA ns 1. Increased security

2. Enhanced internet connectivity
3. Unauthorised data access and corruption
4. Improved system performance

Q .77Q .77 Whic h of the fo l lowing are the bas ic  parameters  of  c y ber  s ec ur ity ?Whic h of the fo l lowing are the bas ic  parameters  of  c y ber  s ec ur ity ?
A nsA ns 1. Communication, intention and availability

2. Confidentiality, integrity and availability
3. Confidentiality, integration and authenticity
4. Collaboration, integrity and availability

Q .78Q .78 The file extens ion us ed to  s ave doc uments  in M S  E xcel  2 0 1 0  is  ________ .The file extens ion us ed to  s ave doc uments  in M S  E xcel  2 0 1 0  is  ________ .
A nsA ns 1. .pptx

2. .docx
3. .bmp
4. .xlsx

Q .79Q .79 What does  the 'CC '  field  s tand for  and what is  its  func t ion?What does  the 'CC '  field  s tand for  and what is  its  func t ion?
A nsA ns 1. 'Contact Copy' is used to add email addresses to the contact list.

2. 'Closed Copy' is used to prevent the email from being forwarded.
3. Carbon Copy is used to send a copy of the email to additional recipients visible to all.
4. 'Confidential Copy' is used to encrypt the email content.

Q .80Q .80 What is  the pr imary  purpos e of a  URL  ( Uniform Res ource L oc ator)  on the web?What is  the pr imary  purpos e of a  URL  ( Uniform Res ource L oc ator)  on the web?
A nsA ns 1. To specify the address of a resource on the internet

2. To identify the type of website
3. To encrypt web traffic
4. To locate the user's position

Q .81Q .81 1 0 % of the voters  in an elec t ion d id  not  c as t  their  votes .  In this  elec t ion,  there were only  two c andidates  and al l  the votes  c as t1 0 % of the voters  in an elec t ion d id  not  c as t  their  votes .  In this  elec t ion,  there were only  two c andidates  and al l  the votes  c as t
were val id .  The winner,  by  obtaining 60 % of the c as ted votes ,  defeated his  c ontes tant by  1 0 8 votes .  What was  the total  number ofwere val id .  The winner,  by  obtaining 60 % of the c as ted votes ,  defeated his  c ontes tant by  1 0 8 votes .  What was  the total  number of
votes  obtained by  the winner?votes  obtained by  the winner?

A nsA ns 1. 234
2. 432
3. 324
4. 554

Q .82Q .82 A  s tudent has  to  obtain 3 3 % of the total  marks  to  pas s .  He got 92  marks  but fa i led  by  4 0  marks .  The maximum marks  are _____ .A  s tudent has  to  obtain 3 3 % of the total  marks  to  pas s .  He got 92  marks  but fa i led  by  4 0  marks .  The maximum marks  are _____ .
A nsA ns 1. 300

2. 400
3. 600
4. 500
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Q .83Q .83 The average of the firs t  24  natural  numbers  is :The average of the firs t  24  natural  numbers  is :
A nsA ns 1. 12

2. 12.5
3. 13.5
4. 13

Q .84Q .84 The rat io  of  expenditure to  s av ings  of a  pers on is  7  :  3.  I f  the inc ome inc reas es  by  2 5% and the s av ing inc reas es  by  8%, then byThe rat io  of  expenditure to  s av ings  of a  pers on is  7  :  3.  I f  the inc ome inc reas es  by  2 5% and the s av ing inc reas es  by  8%, then by
how muc h percentage ( rounded off to  1  dec imal  place)  does  his  expenditure inc reas e?how muc h percentage ( rounded off to  1  dec imal  place)  does  his  expenditure inc reas e?

A nsA ns 1. 32.3%
2. 31.5%
3. 33.2%
4. 35.1%

Q .85Q .85
A nsA ns 1. 3541

2. 3530
3. 3531
4. 3540

Q .86Q .86 A n item is  marked 1 75% higher  than its  c os t  pr ice.  E ven after  a l lowing s ome d is c ount ,  the s hopkeeper  earned 3 2 % profit .  F ind theA n item is  marked 1 75% higher  than its  c os t  pr ice.  E ven after  a l lowing s ome d is c ount ,  the s hopkeeper  earned 3 2 % profit .  F ind the
dis c ount percentage al lowed by  the s hopkeeper.d is c ount percentage al lowed by  the s hopkeeper.

A nsA ns 1. 55%
2. 52%
3. 49%
4. 54%

Q .87Q .87

A nsA ns 1. 1.35
2. 3
3. 0
4. 0.49

Q .88Q .88 E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 80  − 9) } ]E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 80  − 9) } ]
A nsA ns 1. 1469

2. 1609
3. 1684
4. 1539

Q .89Q .89 I  am three t imes  as  o ld  as  my  s on.  Four  y ears  later,  I  s hal l  be two and a half  t imes  as  o ld  as  my  s on.  How o ld  am I  and how o ld  is  myI  am three t imes  as  o ld  as  my  s on.  Four  y ears  later,  I  s hal l  be two and a half  t imes  as  o ld  as  my  s on.  How o ld  am I  and how o ld  is  my
s on?s on?

A nsA ns 1. 40 years and 10 years
2. 45 years and 15 years
3. 36 years and 12 years
4. 50 years and 20 years

Q .90Q .90 A  boat c an move at  a  s peed of 1 6  km/ hr  in s t i l l  water.  The s peed of the s tream is  4  km/ hr.  How muc h t ime ( in minutes)  wi l l  theA  boat c an move at  a  s peed of 1 6  km/ hr  in s t i l l  water.  The s peed of the s tream is  4  km/ hr.  How muc h t ime ( in minutes)  wi l l  the
boat take in going 8  km downs tream and c oming bac k  to  the s ame place?boat take in going 8  km downs tream and c oming bac k  to  the s ame place?

A nsA ns 1. 72
2. 68
3. 60
4. 64
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Q .91Q .91 By  s el l ing an art ic le for  ₹1 9 ,  a  dealer  makes  a  profit of 1 0 %.  By  how muc h s hould  he inc reas e his  s el l ing pr ice ( in ₹ ,  rounded off toBy  s el l ing an art ic le for  ₹1 9 ,  a  dealer  makes  a  profit of 1 0 %.  By  how muc h s hould  he inc reas e his  s el l ing pr ice ( in ₹ ,  rounded off to
two dec imal  places)  s o  as  to  make a profit of 3 0 %?two dec imal  places)  s o  as  to  make a profit of 3 0 %?

A nsA ns 1. 5.45
2. 3.45
3. 4.45
4. 6.45

Q .92Q .92 M ohammad bought 51  books  for  ₹1 ,1 3 5 from one s hop and 4 9 books  for  ₹91 0  from another.  What is  the average pr ice ( in ₹)  he paidM ohammad bought 51  books  for  ₹1 ,1 3 5 from one s hop and 4 9 books  for  ₹91 0  from another.  What is  the average pr ice ( in ₹)  he paid
per  book  ?per  book  ?

A nsA ns 1. 20.25
2. 20.45
3. 20.65
4. 20.95

Q .93Q .93 7  y ears  ago ,  the average age of A ,  B,  and C  was  2 8 y ears .  7  y ears  from now,  the average age of A  and C  wi l l  be 1 8  y ears .  What wi l l7  y ears  ago ,  the average age of A ,  B,  and C  was  2 8 y ears .  7  y ears  from now,  the average age of A  and C  wi l l  be 1 8  y ears .  What wi l l
be the age ( in y ears)  of  B,  7  y ears  from now?be the age ( in y ears)  of  B,  7  y ears  from now?

A nsA ns 1. 89
2. 87
3. 91
4. 90

Q .94Q .94 8 hours  3 0  minutes  is  the t ime taken by  an athlete to  walk  a  d is tance and r ide bac k  on a bic y c le to  the s tart ing place.  I f  9  hours8 hours  3 0  minutes  is  the t ime taken by  an athlete to  walk  a  d is tance and r ide bac k  on a bic y c le to  the s tart ing place.  I f  9  hours
4 5 minutes  is  the t ime taken by  him to  walk  in both way s ,  then find the t ime taken by  him to  r ide in both way s .4 5 minutes  is  the t ime taken by  him to  walk  in both way s ,  then find the t ime taken by  him to  r ide in both way s .

A nsA ns 1. 7 hours 30 minutes
2. 7 hours 15 minutes
3. 7 hours 50 minutes
4. 7 hours 45 minutes

QQ
..
99
55
AA
nn
ss

1. 

2. 
3. 
4. 

Q .96Q .96 L ewis ,  M ic hael ,  and C har les  c an finis h a  certain piece of work  in 1 6 ,  3 6 ,  and 24  day s ,  res pec t ively .  A l l  three of them s tarted theL ewis ,  M ic hael ,  and C har les  c an finis h a  certain piece of work  in 1 6 ,  3 6 ,  and 24  day s ,  res pec t ively .  A l l  three of them s tarted the
work  together.  L ewis  left  the work  after  2  day s  and M ic hael  left  jus t  4  day s  before the work  was  c ompleted .  Find the total  numberwork  together.  L ewis  left  the work  after  2  day s  and M ic hael  left  jus t  4  day s  before the work  was  c ompleted .  Find the total  number
of day s  taken for  the work  to  be c ompleted .of day s  taken for  the work  to  be c ompleted .

A nsA ns 1. 14.2
2. 8.3
3. 19.4
4. 11.2

Q .97Q .97 The c os t  of  the watc h is  inc reas ed by  2 0 % on the firs t  day  and dec reas ed by  1 0 % on the s ec ond day .  What is  the percentageThe c os t  of  the watc h is  inc reas ed by  2 0 % on the firs t  day  and dec reas ed by  1 0 % on the s ec ond day .  What is  the percentage
inc reas e/dec reas e?inc reas e/dec reas e?

A nsA ns 1. 10% decrease
2. 10% increase
3. 8% increase
4. 8% decrease
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Q .98Q .98 O ne pipe c an fil l  a  tank  three t imes  as  fas t  as  another  pipe.  I f  together  the two pipes  c an fil l  the tank  in 24  minutes ,  then theO ne pipe c an fil l  a  tank  three t imes  as  fas t  as  another  pipe.  I f  together  the two pipes  c an fil l  the tank  in 24  minutes ,  then the
s lower  pipe a lone wi l l  be able to  fil l  the tank  in :s lower  pipe a lone wi l l  be able to  fil l  the tank  in :

A nsA ns 1. 

2. 
3. 

4. 

Q .99Q .99

A nsA ns 1. 

2. 

           
3. 

           
4. 

            

Q .1 0 0Q .1 0 0 A  retai ler  buy s  an elec tronic  item for  ₹1 80 .  H is  overhead expens es  are ₹2 0 .  He s el ls  the elec tronic  item for  ₹3 60  and makes  x%A  retai ler  buy s  an elec tronic  item for  ₹1 80 .  H is  overhead expens es  are ₹2 0 .  He s el ls  the elec tronic  item for  ₹3 60  and makes  x%
profit .  The value of x  is :profit .  The value of x  is :

A nsA ns 1. 60
2. 70
3. 100
4. 80
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